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Lr/KSRMCE/CE/2021-22/ Date: 02.04.2022

To

The Principal,
K.S.R.M. College of Engmeermg,
Kadapa.

Sub: KSRMCE - (Civil Engineering Department) Permission to conduct a Certification course on
“Architectural Modeling Using Revit”—Req —Reg.

Respected Sir,

It is being brought to your kind notice that, With reference to the cited, the Civil Engineering
Department is planning to conduct a Certification course on “Architectural Modeling Using Revit” for
B.Tech students from 6" to 12" April 2022 at 9 AM- 4 PM. In this regard I kindly request you to grant

permission to conduct the certification course.

Thankmg you Sir, . X /

&b\/\p ?/ Yours Faithfully

3 < P. Pavan Kumar,
by / Assistant professor,

Dept. of CE

(e

/ksrmceofficial

@/ksrmce‘ac.in Follow Us: Ei @&
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Cr./KSRMCE/CE/AY2021-2022 : Date: 04-04-2022

Circular

All the B. Tech students of KSRMCE are here by informed that Department of Civil Engineering is

going to conduct a Certification course on “Architectural Modeling Using Revit” from 6™ to 12" April

. 2022 at 9 AM - 4 PM. Interested students may register their names with the coordinators P. Pavan Kumar,
~  Assistant Professor and Miss. V. Sai Neeraja, Assistant Professor on or before 5™ April 2022.

Resource Person:

Ms. M. Pravallika,

Technical Skill trainer,

APSSDC.

Coordinators

Mr. P. Pavan Kumar, Assistant Professor in CED

Miss. V. Sai Neeraja, Assistant Professor in CED

oD-CE

Cc to:

IQAC for information

@) /ksrmee.ac.in - Follow Us: EI@ %9 /ksrmceofficial




Registration form for "Certification
course on Architectural Modeling using
REVIT"

Course Instructor: Miss M. Pravalika, Technical Skill Trainer, APSSDC Team

Course Coordinator: Sri P. Pavan Kumar and Miss V Sai Neeraja, Assistant Professors, Civil
Engg. Dept., KSRMCE

Date: 06/04/2022 to 12/04/2022

reddysrinu@ksrmce.ac.in Switch account

@

Your email will be recorded when you submit this form

* Required

Roll No. *

Your answer

Name of the student *

Your answer

Branch *

Your answer

Never submit passwords through Google Forms.

This form was created inside of KSRM College of Engineering. Report Abuse /
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Department of Civil Engineering
Name of the Event: Cettification course on “Architectural Modeling Using REVIT”
List of Participants

SI.NO. Roll No. Name of the student Branch
1 199Y1A0109 | Dirasantha Chennakeshava CIVIL
2 199Y1A0110 | G.Mahamad Javid CIVIL
3 199Y1A0115 | H Faheem CIVIL
4 199Y1A0116 | Janapati Venkata Sai CIVIL
5 199Y1A0131 M.Harsha Vardhan CIVIL
6 199Y1A0153 | Shaik Imran CIVIL
7 199Y1A0157 | Shaik.Mustan CIVIL
8 199Y1A0159 | S. Venkata Sai Pavan CIVIL
9 199Y1A0162 | Syed Mohammed Junaid CIVIL
10 199Y1A0169 | Varadhigandla Sreenivasulu CIVIL
11 209Y5A0104 | B Surendra CIVIL
12 209Y5A0116 | D Sivanityam CIVIL
13 209Y5A0122 | Giddaluru Santhosh CIVIL
14 209Y5A0132 | Kodivalasa Jyothi Sujatha CIVIL
15 209Y5A0137 L.Dwarakanath Reddy CIVIL
16 209Y5A0139 | Maduru Venkata Naveen Kumar CIVIL
17 209Y5A0143 | M Ganesh CIVIL
18 209Y5A0146 | M. Kiran Kumar Reddy CIVIL
19 209Y5A0153 | Nimmakayala Sowjanya CIVIL
20 209Y5A0156 | Paidepalli Asma: CIVIL
21 209Y5A0159 | Pesala Ajay Kumar CIVIL
22 209Y5A0168 | R.Mabujan CIVIL
23 209Y5A0179 | Ummadi Venkata Teja CIVIL
24 209Y5A0181 | V.Gayathri CIVIL
25 209Y5A0188 | Yenumula Venugopal CIVIL

\ !
Co-ordinators HOD (Civil) Principal
Head PRINCIPAL

Department of Civil EnglaceriiOS.R.M. COLLEGE OF ENGINEERING
K.S.R.M. Coliega of Engineering  KADAPA . 515 003. (A.P.)

(Autonomous)
KADAPA 516 003. (AP)
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Syllabus of Certification Course
Course Name: Architectural Modeling Using REVIT

Table of Contents
1. Introduction to Building Information Modeling
Revit Architecture Introduction
User Inter Face
Setting of Units & Working with Elevation Views
Placing Walls, Doors & windows
Editing of Walls, Doors & Windows
Properties Palette
o Type Selector
o Type Parameters
o Instance Parameters
8. Managing Views by Project Browser
9. Placing of Family Files(Components)
10. Modify Tools
11. Roof & Types of Roofs
12. Floor & Types of Floors
13. Ceiling
14. Explain about Curtain wall
15. Creating Section Views
16. Different Types of Openings
17. Staircase
18. Ramp
19. Railing
20. Annotations
21. Model Text
22. 3-D Views
o Camera Views
o Rendering
o Walkthroughs
23. Paint
24. Creating New Materials
25. Massing & Site
26. Schedules
27. Page Layout
28. Documentation
29. Project Submission
Textbooks:
1. Atefe Makhmalbaf (2022), Building Information Modeling using Revit for Architects and
Engineers, Mavs Open Press.
2. Revit Essentials for Architecture by Paul F. Aubin, https://paulaubin.com/books/revit-
essentials-for-architecture/.

N
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Department of Civil Engineering
Certification course on “Architectural Modeling Using REVIT”
Date Timing | Course Instructor Topic to be covered
06/04/2022 | 9 AM to | Miss. M. Pravalika Introduction to Building Information
12 PM | Technical Skill Trainer, APSSDC Modeling, Revit Architecture Introduction
06/04/2022 | 1PMto | Miss. M. Pravalika User Inter Face, Setting of Units & Working
4PM | Technical Skill Trainer APSSDC with Elevation Views, Placing Walls, Doors
& windows
07/04/2022 | 9 AM to | Miss. M. Pravalika Editing of Walls, Doors & Windows,
12PM | Technical Skill Trainer APSSDC Properties Palette, Managing Views by
Project Browser
07/04/2022 | 1PMto | Miss. M. Pravalika Placing of Family Files (Components),
4PM | Technical Skill Trainer APSSDC Modify Tools, Roof & Types of Roofs
08/04/2022 | 9 AM to | Miss. M. Pravalika Floor & Types of Floors, Ceiling
12 PM | Technical Skill Trainer APSSDC
08/04/2022 | 1 PMto | Miss. M. Pravalika Explain about Curtain wall, Creating Section
4 PM | Technical Skill Trainer APSSDC Views
09/04/2022 | 9 AM to | Miss. M. Pravalika Different Types of Openings, Staircase
12 PM | Technical Skill Trainer APSSDC
09/04/2022 | 1 PMto | Miss. M. Pravalika Ramp, Railing, Annotations, Model Text
4 PM Technical Skill Trainer APSSDC
11/04/2022 | 9 AM to | Miss. M. Pravalika 3-D Views
12 PM | Technical Skill Trainer APSSDC
11/04/2022 | 1 PM to | Miss. M. Pravalika Paint, Creating New Materials
4 PM | Technical Skill Trainer APSSDC
12/04/2022 | 9 AM to | Miss. M Pra\.ralika. Massing & Site, Schedules, Page Layout
12 PM | Technical Skill Trainer APSSDC
12/04/2022 | 1 PM to | Miss. M. Pravalika Documentation, Project Submission
4 PM Technical Skill Trainer APSSDC

Instructor: }7 : /7 97[7\\/6\!:“(0\

Coordinators: y
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Department of Civil Engineering

Attendance sheet of Certification Course on Architectural Modeling Using REVIT

06/ [ 06/ |07/ |07/ | 08/ | 08/ | 09/ | 09/ |10/ | 10/ |11/ | 11/ 12/
X Student Roll 04 04 04 04 04 04 04 04 04 04 04 04 04
N No. Student Name FN | AN | FN | AN | EN | AN | FN | AN |FN | AN | FN | AN |FN
0. ; i - 4
1 | 199Y1A0109 | Dirasantha Chennakeshava M get eA| pek p(/(, pA M pd( Wi o M ppll M M
2 | 199Y1A0110 | G.Mahamad Javid (w,."/:f?,’-‘f'/ Q/{x‘/tﬁ/@%hﬂw :f‘/ QS\-/G(”‘/‘Q"/QV(K
3 | 199Y1A0115 | H Faheem g /L,’ e [ ,/),«, // /)_ﬂ/(— i‘/" [//4 ﬁ& 7}?“ o 76- /4‘
4 | 199Y1AO0116 | Janapati Venkata Sai ;ﬂ(‘w b X W %M g‘ww %@2 . é&u}/ -
— | de | de& (4% = i
5 | 199Y1A0131 | M.Harsha Vardhan Mo |44 ﬂ & % A . o, # 9‘4 5213- M A
i AR 0 QIS Tl Tl
7 | 199Y1A0157 Shalk.Mustan. S\“\OV g\\}\/({\” S’W&V M‘Q\W’ﬁ {\AAQ\N—Q LI Q &Wz{\w ¢ Var
8 | 199Y1A0159 | S. Venkata Sai Pavan AN S\VP il i ,\_M/Az SJP— Q‘/;» QR &FM,Q\/’P" G- Byp- | .
9 | 199Y1A0162 | Syed Mohammed Junaid QMQ‘KS_,Q“ /Q,\J@\ @'M\MQ\V;&QV&S @Q\ﬁQkﬁ(%ﬁg\rﬂ(
! \ APDE N . ; ,
199Y1A0169 | Varadhigandla Sreenivasulu \)thwk )}},fl Q”\ Ogh th:j B G )Q/«y Vi QM sl ’ON
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11 | 209Y5A0104 | B Surendra mrar AN 74V 7al//4 747 74 )4/
12 | 209Y5A0116 | D Sivanityam C/Va (ivm .S,It'uw Al é‘wk o el | S i ,,Ccu. Pl |Sod A
13 | 209Y5A0122 | Giddaluru Santhosh o, Frry g M%ﬁ MZA;. Wﬁ[ ﬁb% /).
14 | 209Y5A0132 | Kodivalasa Jyothi Sujatha N fwwh Qy/g/gi g/ | S,./g—' gg}__
15 209Y5A0137 L.Dwarakanath Reddy A ?/’D}/“\:?/W’Lé/ D‘-’“‘@-‘/L\/ '—5/'2_’/(&_“0/
16 | 209Y5A0139 II\</Iaduru Venkata Naveen W gauhumet \utasl Wiseel Wiass, MW? Wy Ay Valotng | el v
umar ; A ) ;
17 | 209Y5A0143 | M Ganesh ( l\w«/ (>f‘( i i 1L, @RAIEEA AT SO (et gee
18 | 209Y5A0146 | M. Kiran Kumar Reddy b LR e l"‘* P [5”“/ JeZp hnn /‘*‘t e //W RAB AN A
19 | 209Y5A0153 | Nimmakayala Sowjanya O g,‘,m ( L (: ( g,,.,L Q Sﬂ
20 | 209Y5A0156 | Paidepalli Asma o, |- [ 7o [ Potac Ao | A8 o e o s e [ B
21 | 209Y5A0159 | Pesala Ajay Kumar e g 4y P Ny ot iid | Bty |
22 | 209Y5A0168 | R Mabujan | s T e by Wil e MoRWoHMab | Mo
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Resource person
M:ss M Pravahka

.

Techmcal Sk

under the gqverna}pt‘g of APéSPC’in asso‘qa{i‘:idn‘»iwth CRI, KSRMCE

‘;’féOnéf‘week certiﬁgaﬁtion course

Arehitecturall Mo elmg u,smg

APSSDC Team

‘R&‘U‘I‘T

S

Ilz Tramer

maranatha Reddy

Coar‘dtnators Sri P Pavan Kumar M:ss V Sai Neert: |

Prof. V S S Murthy Dr. K Chandra Obul Reddy Smt. K Rajeswari sri K Madan Mohan Ry
Principal Management Director Correspondent Secretary, Vice Chairman
Treasurer

CRI Lab

~ Starts: 06- 04 2022
~09.00 AM - 04.00 PM

'Sri K Raja Mohan Reddy

Chairman
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ACTIVITY REPORT

One week Certification Course

On

“Architectural Modeling using REVIT”

06 April, 2022 to 12t April, 2022

Target Group : VI SEM Students

Details of Participants s 25 Students

Co-Ordinator(s) _ - Sri. P. Pavan Kumar and Miss V Sai Neeraja
Organizing Department : Civil Engineering

Venue - CRI Lab, KSRMCE

REVIT is a BIM tool developed by Autodesk used for special Designs, Modelling,
Visualization, and Documentation. BIM (Building Information Modelling) is a process
to plan, design, construct and manage a project based on the intelligent prototype
developed to advanced constructions and coordination through the modelling during
the project life cycle. The present certification course was arranged to enhance the
knowledge on AutoDesk REVIT software to students and give exposure from skilled
trainers. The main theme of this certification course is to expose the scope of REVIT
to students and to enhance their knowledge.

The Certification course was arranges by Department of Civil Engineering for the
B.Tech. III" year students. The venue was CRI lab, PG Block, KSRMCE. The course
was planned for six days from 06% to 12t April, 2022. Each day Certification course
was organized as two sessions, morning section from 9 AM to 12 PM and Evening
session form 1 PM to 4 PM. All the sessions were hosted by Dr. Amaranatha Reddy
(HOD), Sri. P. Pavan Kumar and Miss V Sai Neeraja. A total of 25 students of
Department of Civil Engineering were actively participated in the Certification course.

@) /ksrmee.ac.in - Follow Us: =¥ /ksrmceofficial
At



Picture:

The photograph taken during the course is given below:

L _ane >4 e % ) & i i = N

Mechanical Engineering Bloc Host
Pradesh 516003, India

Latitude Longitude

14.47592° 78.76611°

Local 10:49:37 AM Altitude 464 meters
GMT 05:19:37 AM Wednesday; 06-04-2022

ey

Co-ordinators D-CE

Head
Department of Civil Englneeﬁng
K.S.R.M. College of Engineering
(Autonomous)
KADAPA 516 003. (AP)
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(Department of Skills Development & Training, Govt. of Andhra Pradesh)

Cert.No. REVIT/STP/2655 Regdld: 209Y5A0116

This is to certify that Mr./Ms./Mrs....cocommrmnioiinnnees S A VAT aiids vunvervisves st kusninibnrs
OF i iionirsasessastrsonsinssarmnee PR Collocemgfal i HIeerng. . ... ... suresnnsssssss 1185 SUCCESSIUNY

participated Training Program on ................. Architectural Modelling

held from .....06:04:2022..........80%%.. .. 120432000, . 4

Principal (or) HOD Dr. Ravi K Gujjula Sri S. Satyanarayana, IAS
Chief General Manager (Technical) Managing Director
APSSDC ; APSSDC




Andhra Pradesh State Skill Development Corporation (APSSDC)

(Department of Skills Development & Training, Govt. of Andhra Pradesh)

Cert.No. REVIT/STP/2644 Regdld: 199Y1A0109

Dirasantha Chennakeshava...cocvieeeieieeninenens

LI i s b s s exs TBE SUCCESEIULY
participated Training Program on ............... .. Architectural Modelling Using Revit............

held from .....00:04:2022........... 0. 5. 12042022 ... 4

T

Dr. Ravi K Gujjula Sri S. Satyanarayana, IAS

Chief General Manager (Technical) Managing Director
APSSDC APSSDC




Andhra Pradesh State Skill Development €orporation (APSSDC)

(Department of Skills Development & Training, Govt. of Andhra Pradesh)

Cert.No. REVIT/STF/2659

This is to certify that Mr./Ms./Mrs.......

P i e b Bl

participated Training Program on

held from ......06:04:2022

Dr. Ravi K Gujjula Sri S. Satyanarayana, IAS
Chief General Manager (Technical) Managing Director
APSSDC APSSDC




Andhra Pradesh State Skill Development Corporation (APSSDC)

(Department of Skills Development & Training, Govt. of Andhra Pradesh)

REVIT/STP/2662

This is to certify that Mr./Ms./Mrs............ Blimmiakavala SOWJaNYa.. .. ivesesesnnsesnsionannns

of o JKSRM Collecesaifliiiiiiccring. L e ere 1185 SUCCESSTUTY

participated Training Program on

held from ......00:04:2022

Sri S. Satyanarayana, IAS

Chief General Manager ( Technical) Managing Director
APSSDC




Feedback ‘»form for "Certification course
on Architectural Modeling using REVIT"

reddysrinu@ksrmece.ac.in Switch account

&

Your email will be recorded when you submit this form

* Required

Name of The Student *

Your answer

Roll. No. *

Your answer

Trainee Communication Skills *

O Excellent



Content delivered by the trainee *

(O Excellent

(O Good
O Fair
O Poor

Weather the Course is improved your knowledge *

O Yes
O No

Is the lecture hours sufficient? *

O Yes
O No

Rate the entire course? *
1-Low, 5-High

10
2 O

. @ O



.

Department of Civil Engineering

Feedback of students on Certification Course on “Architectural Modeling Using REVIT”

Weather the
Trainee Coutse is Is the lecture Rate the
Sl. Communication | Content delivered | improved your hours entire
No.| Roll No. Name of The Student Skills by the trainee knowledge sufficient? course?
1] 199Y1A0109 | Dirasantha Chennakeshava Excellent Excellent Yes Yes 5
2| 199Y1A0110 | G.Mahamad Javid Excellent Excellent Yes Yes 5
3| 199Y1A0115 | H Faheem Good Excellent Yes Yes 5
4| 199Y1A0116 | Janapati Venkata Sai Excellent Excellent Yes Yes 5
5| 199Y1A0131 | M.Harsha Vardhan Excellent Excellent Yes Yes 5
6| 199Y1A0153 | Shaik Imran Excellent Excellent Yes Yes 5
7| 199Y1A0157 | Shaik.Mustan Excellent Excellent Yes Yes 5
8| 199Y1A0159 | S. Venkata Sai Pavan Excellent Excellent Yes Yes 5
9| 199Y1A0162 | Syed Mohammed Junaid Excellent Excellent Yes Yes 5
10 | 199Y1A0169 | Varadhigandla Sreenivasulu Excellent Excellent Yes Yes 5
11 | 209Y5A0104 | B Surendra Excellent Good Yes Yes 4
12 | 209Y5A0116 | D Sivanityam Excellent Excellent Yes Yes 5
13 | 209Y5A0122 | Giddaluru Santhosh Excellent Excellent Yes No 5
14 | 209Y5A0132 | Kodivalasa Jyothi Sujatha Excellent Excellent Yes Yes 5
15 | 209Y5A0137 | L.Dwarakanath Reddy Excellent Excellent Yes Yes 5
16 | 209Y5A0139 | Maduru Venkata Naveen Kumar Excellent Excellent Yes Yes 5




17 1 209Y5A0143 | M Ganesh Excellent Excellent Yes Yes 5
18 | 209Y5A0146 | M. Kiran Kumar Reddy Excellent Excellent Yes Yes 5
19 | 209Y5A0153 | Nimmakayala Sowjanya Excellent Good Yes Yes 4
20 | 209Y5A0156 | Paidepalli Asma Excellent Excellent Yes Yes 5
21| 209Y5A0159 | Pesala Ajay Kumar Excellent Excellent Yes Yes 5
221 209Y5A0168 | R.Mabujan Excellent Excellent Yes Yes 5
23 | 209Y5A0179 | Ummadi Venkata Teja Excellent Excellent Yes Yes 5
24 | 209Y5A0181 | V.Gayathri Excellent Excellent Yes Yes 5
25| 209Y5A0188 | Yenumula Venugopal Excellent Excellent Yes Yes 5

Coordinatoy

/

Head

K.S.R.M. Collea2 O

k/\/ /‘/
\\ //JJ,. 4
HbD/-C/ivil Engg.

(Autonomous)

003. (AP)

§ Civil Englp.eeﬁ_ng
Departfﬂeﬂ't ¥ f Engineering
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K.S.R.M. COLLEGE OF ENGINEERING (AUTONOMOUS), KADAPA-516003
DEPARTMENT OF CIVIL ENGINEERING

Certificate Course Architectural Modeling using REVIT

Marks Award List

S.No Nl?n?:)ler Name of the Student Oll\ontaa :'r(‘z d
1 199Y1A0109 | Dirasantha Chennakeshava 14
5 199Y1A0110 | G.Mahamad Javid 19
3 199Y1A0115 | H Faheem 17
4 199Y1A0116 | Janapati Venkata Sai 18
5 199Y1A0131 | M.Harsha Vardhan 17
6 199Y1A0153 | Shaik Imran 8
. 199Y1A0157 | Shaik.Mustan 19
8 199Y1A0159 | S: Venkata Sai Pavan 17
9 199Y1A0162 | Syed Mohammed Junaid 19
10 199Y1A0169 | Varadhigandla Sreenivasulu 19
11 209Y5A0104 | B Surendra 15
12 209Y5A0116 | D Sivanityam 13
13 209Y5A0122 | Giddaluru Santhosh 11
14 209Y5A0132 | Kodivalasa Jyothi Sujatha 7s
15 209Y5A0137 | L.Dwarakanath Reddy 17

209Y5A0139 | Maduru Venkata Naveen
16 Kumar 16
17 209Y5A0143 | M Ganesh 14
18 209Y5A0146 | M. Kiran Kumar Reddy 19
19 209Y5A0153 | Nimmakayala Sowjanya 16
20 209Y5A0156 | Paidepalli Asma 17
21 209Y5A0159 | Pesala Ajay Kumar 15
99 209Y5A0168 | R.Mabujan 17
23 209Y5A0179 | Ummadi Venkata Teja 7
o4 209Y5A0181 | V.Gayathri 18
o5 209Y5A0188 | Yenumula Venugopal 16

Department of Civil Ena
K.S.R.M. Coile
(Autonomous)

KADAPA - 516 003. (A.P)
4




K.S.R.M. COLLEGE OF ENGINEERING (AUTONOMOUS), KADAPA-516003

Time: 20 Min

DEPARTMENT OF CIVIL ENGINEERING
Certificate Course on Architectural Modeling using REVIT
Assessment Test

Name of the Student: M- |Jar& C\@ V&YcJLAQReg. Number: _ 1 QY1 4013 )

(Objective Questions)

Max. Marks: 20

Note: Answer the following Questions and each question carries one mark.

D/

x

S

S

1 | What is Revit primarily used for in the field of architecture?
y . C) Spreadsheet D) Building information

2By B):SDigaming calculations modeling (BIM)

2 | In Revit, what is a "Family"?
A) Group of B) A 2
achecs. | representaton | APt | DLApeenel | LRy
working together | of a building 9 P

3 | What does "BIM" stand for in the context of architectural software?

: : B) Building C) Beautiful D) Blueprint
/Q)OEZFIC Imaging Information lllustration Information [ig
Modeling Method Management

4 | What is the purpose of "Levels" in Revit?
A) To define the | B) To set the C) To define
number of floors | building's horizontal planes :ij)hl-icr)m C?r?t:)rlggri [G/‘
in a building structural load | in a building gnting

5 | What does the term "Parametric" mean in the context of Revit?
A) A type of 8201225 o C) A modeling D) Design elements [ d
architectural Ere ating visual technique without | that are driven by
style ftarte constraints relationships and rules

6 | Which Revit tool is used for creating walls, doors, windows, and other building
elements? [J]\’
A) Sketch tool ’I?o)ollz’alntbrush C) Line tool D) Create tool

7 | In Revit, what is a "View" used for?
A) Changing the | B) Exporting C) Displaying a D) Generating cost [5]&
color scheme of | the model to specific portion of | estimates for
the model other software | the model construction

8 | What is the purpose of "Families" in Revit?
Ar)oTJO ;‘eo;;resent B) To organize | C) To manage D) To define reusable
grchi?ects project files project schedules | building components

9 | Which feature in Revit helps ensure that changes made in one view are
automatically reflected in all related views? [A]
AJVIE, B) Styles C) Filters D) Renderings 5
Templates

10 | Which Revit tool allows you to create 3D models by extruding 2D shapes? [Q]/!




A) Extrude tool

| B) Convert tool

| C) Build tool

| D) Extend tool

N

N

R

11 | What is a "Sheet" in Revit used for?
: C) A printed or
A) A virtual D tqol for di)gitaFI) D) A tool for managing [g]
workspacg for sketch_lng representation of | building components
collaborating rough ideas a drawing
12 | What is the primary purpose of using "Tags" in Revit?
AL To Iabgl B) To create ) to spphy D) To generate [ )/}
glrznv?/i?:gs e 3D models tsixr:c:rceessto construction schedules y
13 | What is the purpose of the "Project Browser" in Revit?
A) To browse the | B) To access
internet for project ) To r?$nage d D) To connect to cloud a
design management p_rOJect s storage services
STy views
inspiration software
14 | What does the "Render" tool in Revit allow you to do?
C) Create
A) Organize 5’1)05;?80{:) visualizations of Es)ﬁ?ningaggrcw [ ID
projsctiiies other formats thewniding’s construction
appearance
15 | In Revit, what is a "Curtain Wall"?
A) A wall with B) A type of C) A decorative D) An exterior wall
curtains for window architectural system with glass [P
privacy treatment element panels
16 | How can you adjust the visibility of objects in different views using Revit's
"Visibility Graphics" tool?
B) By C) By controlling
A) By resizing changing the the visibility of D) By creating new ] \
objects materials of categories and objects
objects elements
17 | Which tool in Revit is used for creating a 3D view of the building's exterior?
A) Elevation tool | B) Section tool | C) Floor Plan tool | D) Perspective tool A
18 | What is the purpose of "Worksets" in a collaborative Revit environment?
A) To create B) To manage o) T : D) To enable multiple
backups of project ) To organize users to work on
e Tl ceFadiiles project teams dlﬁgrent .parts of the
prol project simultaneously
19 | Which Reuvit feature allows you to adjust the materials and finishes of building
components?
f‘.) Material B) Materlal C) Color Picker D) Texture Tool
ibrary Painter
20 | How can you add dimensions and annotations to a drawing in Revit?

A) Using the Text
tool

B) Using the
Line tool

C) Using the

Dimension tool

D) Using the Paint tool

BN
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Max. Marks: 20

Note: Answer the following Questions and each question carries one mark.

1 | What is Revit primarily used for in the field of architecture?

C) Spreadsheet

D) Building information

1)

S

PR 2RidrEting 8)8B.gaming calculations modeling (BIM)
2 | In Revit, what is a "Family"?
A) Group of B) A ;
architects representation 3)85‘3%’22%8; L E) igiﬁarignnfm% o [’@ﬂ'
working together | of a building g pene
3 | What does "BIM" stand for in the context of architectural software?
: : B) Building C) Beautiful D) Blueprint
'ICI)OISZFIC Imaging Information lllustration Information [B]
Modeling Method Management
4 | What is the purpose of "Levels" in Revit?
A) To define the | B) To set the C) To define &
number of floors | building's horizontal planes :ij)h-‘lc-icr)\ cci):t;orlggsq LA]’
in a building structural load | in a building gnting
5 | What does the term "Parametric" mean in the context of Revit?
A) A type of Boncgis o C) A modeling D) Design elements @]
architectural Ereati ng visual technique without | that are driven by
style eftacta constraints relationships and rules
6 | Which Revit tool is used for creating walls, doors, windows, and other building
elements?

A) Sketch tool

B) Paintbrush
tool

C) Line tool

D) Create tool

7 | In Revit, what is a "View" used for?

A) Changing the | B) Exporting C) Displaying a D) Generating cost [ A‘
color scheme of | the model to specific portion of | estimates for ;
the model other software | the model construction

8 | What is the purpose of "Families" in Revit?

A) To represent
groups of
.| architects

B) To organize
project files

C) To manage
project schedules

D) To define reusable
building components

9 | Which feature in Revit helps ensure
automatically reflected in all related views?

that changes made in one view are

A) View

B) Styles

Templates

C) Filters

D) Renderings

10

Which Revit tool allows you to create 3D models by extruding 2D shapes?

X\XX s \>< \><




A) Extrude tool | B) Convert tool | C) Build tool | D) Extend tool

What is a "Sheet" in Revit used for?

A) A virtual B) A tool for C) A printed or

K ¢ ketchi digital D) A tool for managing
wo”r Epacfe or foe % ;ggas representation of | building components
collaborating | ug a drawing A ‘
What is the primary purpose of using "Tags" in Revit?
A) To label C) To apply

: B) To create D) To generate [ @-/

elements in a textures to . S
drawing 3D models stirfaces construction schedules

What is the purpose of the "Project Browser" in Revit?

A) To browse the | B) To access C) To manage

internet for project ; : D) To connect to cloud

design management Pr oject files and storage services

b e views

inspiration software
{ What does the "Render" tool in Revit allow you to do?

C) Create
A) Organize B) Export visualizations of D) Qenerate cost
: : models to S estimates for

projgerfiics other formats Lehudicos construction
i appearance

In Revit, what is a "Curtain Wall"?

A) A wall with B) A type of C) A decorative D) An exterior wall 0]
| curtains for window architectural system with glass \

privacy treatment element panels

How can you adjust the visibility of objects in different views using Revit's
"Visibility Graphics" tool?

B) By C) By controlling [q
.A) By resizing changing the the visibility of D) By creating new \
objects materials of categories and objects
objects elements

Which tool in Revit is used for creating a 3D view of the building's exterior?

A) Elevation tool | B) Section tool | C) Floor Plan tool | D) Perspective tool

| What is the purpose of "Worksets" in a collaborative Revit environment?

D) To enable multiple

A) To create B) To manage :

: C) To organize users to work on
baclajps of project roject teams different parts of the
project files schedules proj p

project simultaneously

Which Revit feature allows you to adjust the materials and finishes of building
components?

A) Material B) Material :

How can you add dimensions and annotations to a drawing in Revit?

A) Using the Text | B) Using the C) Using the = :
tool Line tool Bimehaion foc) D) Using the Paint tool

NS A
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1

What is Revit primarily used for in the field of architecture?

: : C) Spreadsheet D) Building information [A]
A 2Bigraming B) 2D gaming calculations modeling (BIM)
2 | In Revit, what is a "Family"?
A) Group of B) A )
architects representation a)sﬁa:épa?ig:\ S E) ‘@iparametrlc ¢ /[Q]/
working together | of a building LIBNY COmPONE. . ¢
3 | What does "BIM" stand for in the context of architectural software?
: . B) Building C) Beautiful D) Blueprint ;
:‘A)og:flc Imaging Information lllustration Information 2 B
Modeling Method Management
4 |'What is the purpose of "Levels" in Revit?
A) To definethe | B) Tosetthe | C) To define /ﬁ
number of floors | building's horizontal planes E)h-[iz C?:tarorl;;‘;
in a building structural load | in a building ghting A
5 | What does the term "Parametric’ mean in the context of Revit?
A) A type of B)line C) A modeling D) Design elements /ﬁ
: process of i : : /
architectural - : technique without | that are driven by
creating visual 7 : X
style constraints relationships and rules
effects
6 | Which Revit tool is used for creating walls, doors, windows, and other building
elements?
A) Sketch tool @Ofalntbrush C) Line tool D) Create tool /}Q/
7 | In Revit, what is a "View" used for?
A) Changing the | B) Exporting C) Displaying a D) Generating cost /KJ/
color scheme of | the model to specific portion of | estimates for 5
the model other software | the model construction
8 | What is the purpose of "Families" in Revit?
AZOEO sreog]zresent B) To organize | C) To manage D) To define reusable JP{
grchiFt)ects project files project schedules | building components
9 | Which feature in Revit helps ensure that changes made in one view are
automatically reflected in all related views? [ ]q
L e B) Styles C) Filters D) Renderings /
Templates
10 | Which Revit tool allows you to create 3D models by extruding 2D shapes? | [N




A) Extrude tool

| B) Convert tool | C) Build tool

| D) Extend tool

11

What is a "Sheet" in Revit used for?

A) A virtual

B) A tool for

C) A printed or

\ )

13

What is the purpose of the "Project Browser" in Revit?

. digital D) A tool for managing
wo”rkspact_e for sketcr:"hilgga representation of | building components //[Q/
collaborating rough ideas a drawing

12 | What is the primary purpose of using "Tags" in Revit?
A) To label C) To apply
¢ B) To create D) To generate
elementsina textures to X
drawing 3D models T construction schedules
Y]

A) To browse the

B) To access

C) To manage

internet for project : 2 D) To connect to cloud
design management \F/)irg\J:sCt fiies and storage services
inspiration software

14

What does the "Render" tool in Revi

t allow you to do?

C) Create

A) Organize B) Export visualizations of D) _Generate coot /[/(
s models to e estimates for ]

BiojectTles other formats Temigs construction

appearance

15 | In Revit, what is a "Curtain Wall"?

A) A wall with B) A type of C) A decorative D) An exterior wall [ﬂ
curtains for window architectural system with glass 7
privacy treatment element panels

16

How can you adjust the visibility of objects in different views using Revit's
"Visibility Graphics" tool?

B) By C) By controlling /[E]/
A) By resizing changing the the visibility of D) By creating new
objects materials of categories and objects

objects elements

17

Which tool in Revit is used for creating a 3D view of the building's exterior?

A) Elevation tool | B) Section tool [ C) Floor Plan tool | D) Perspective tool

18

What is the purpose of "Worksets" in a collaborative Revit environment?

A) To create
backups of
project files

B) To manage
project
schedules

C) To organize
project teams

D) To enable multiple
users to work on
different parts of the
project simultaneously

19

Which Revit featur

e allows you to adjust the materials and finishes of building

components? }8]/
A) Material B) Material : ’
| Library Paintar C) Color Picker D) Texture Tool
20 | How can you add dimensions and annotations to a drawing in Revit? LA
A) Using the Text | B) Using the C) Using the ; .
tool Line tool Dimension tool B)iUsing the Paint tool
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Note: Answer the following Questions and each question carries one mark.

1 | What is Revit primarily used for in the field of architecture?

C) Spreadsheet

D) Building information

A
il

£) 2D draiting B) 3D.gaming calculations modeling (BIM)
2 | In Revit, what is a "Family"?
A) Group of B) A .
achtecs | representaton | JAERATD | DI Spaen
working together | of a building LG i
3 | What does "BIM" stand for in the context of architectural software?
. ’ B) Building C) Beautiful D) Blueprint
':A‘)O‘Z’ZIS'C Imaging Information lllustration Information !&
Modeling Method Management
4 | What is the purpose of "Levels" in Revit?
A) To define the | B) To set the C) To define
number of floors | building's horizontal planes E)hIi(; C?:tarorlcfgri [ Q
in a building structural load | in a building gnting

5 | What does the term "Parametric" mean in the context of

Revit?

A) A type of e C) Amodeling | D) Design elements | |
architectural prace : technique without | that are driven by ,ﬁb
creating visual ; : :
style Sl constraints relationships and rules
6 | Which Revit tool is used for creating walls, doors, windows, and other building
elements?

A) Sketch tool

B) Paintbrush
tool

C) Line tool

D) Create tool

b
A
e

S

7 | In Revit, what is a "View" used for?

A) Changing the | B) Exporting C) Displaying a D) Generating cost 1
color scheme of | the model to specific portion of | estimates for Q_<
the model other software | the model construction

8 | What is the purpose of "Families" in Revit?

A) To represent

B) To organize

C) To manage

D) To define reusable

g;gﬁﬁzcﬁl project files project schedules | building components
9 | Which feature in Revit helps ensure that changes made in one view are
automatically reflected in all related views?
A) Ve B) Styles C) Filters D) Renderings
Templates
10 | Which Revit tool allows you to create 3D models by extruding 2D shapes?




A) Extrude tool

| B) Convert tool

| C) Build tool

| D) Extend tool

11 | What is a "Sheet" in Revit used for?
- C) A printed or
Sl Eigline for diz;itaﬁJ D) A tool for managing [Ck
workspacg for sketch_lng representation of | building components
collaborating rough ideas a drawing
12 | What is the primary purpose of using "Tags" in Revit?
A) To labgl B) To create C) To apply D) To generate
Slrzr\zﬁrgs e 3D models tsixr;:::eessto construction schedules JQYL
13 | What is the purpose of the "Project Browser" in Revit?
A) To browse the | B) To access
inzternet for project C) _To trr:c?nage d D) To connect to cloud | [(] |
design management Ripjestilico:an storage services
SR views
inspiration software
14 | What does the "Render" tool in Revit allow you to do?
C) Create
A) Organize B) Bxport visualizations of D) _Generate cast ‘@F
; : models to ey, estimates for
projecrifies other formats W buldings construction
appearance
15 | In Revit, what is a "Curtain Wall"?
A) A wall with B) A type of C) A decorative D) An exterior wall
curtains for window architectural system with glass ,D
privacy treatment element panels
16 | How can you adjust the visibility of objects in different views using Revit's
"Visibility Graphics" tool?
B) By C) By controlling ﬂf
A) By resizing changing the the visibility of D) By creating new =
objects materials of categories and objects
objects elements
17 | Which tool in Revit is used for creating a 3D view of the building's exterior?
A) Elevation tool | B) Section tool | C) Floor Plan tool | D) Perspective tool
18 | What is the purpose of "Worksets" in a collaborative Revit environment?
D) To enable multiple
Q; Togeate bl Toimanggo C) To organize users to work on ﬁ)
chiips of projéct roject teams different parts of the
project files schedules pro) : P
project simultaneously
19 | Which Revit feature allows you to adjust the materials and finishes of building
components? &
f‘.) Material B) Materlal C) Color Picker D) Texture Tool
ibrary Painter
20 | How can you add dimensions and annotations to a drawing in Revit?
A) Using the Text | B) Using the C) Using the - - ]
to)ol - Li)ne toogf Dimens?on tool DytsingitheFaint too! G’/

SR
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Note: Answer the following Questions and each question carries one mark.

1 | What is Revit primarily used for in the field of architecture?

A) 2D drafting

B) 3D gaming

C) Spreadsheet

D) Building information

[

S e

calculations modeling (BIM)
2 | In Revit, what is a "Family"? A
A) Group of B) A .
azchitecfs representation C.) - t.ype‘ of 3B D) _A_parametrlc [B]
working together | of a building visualization building component
3 | What does "BIM" stand for in the context of architectural software?
A) Basic Imaging B) Buildipg C) Beagtiful D) Blueprint [
Model Inform‘atlon lllustration Information }/
Modeling Method Management 3
4 | What is the purpose of "Levels" in Revit?
A) To definethe | B) To set the C) To define
number of floors | building's horizontal planes :ij)h-!c—iz c?:tarorlot(?; )/d
in a building structural load | in a building gnting
5 | What does the term "Parametric" mean in the context of Revit?
A) A type of B} ithe C) A modeling D) Design elements
architectural progess O.f technique without | that are driven by [A
creating visual i : s
style constraints relationships and rules

effects

6 | Which Reuvit tool is used for creating walls, doors, windows, and other building

elements?

N

A) Sketch tool

B) Paintbrush
tool

C) Line tool

D) Create tool

7 | In Revit, what is a

"View" used for?

A) Changing the | B) Exporting C) Displaying a D) Generating cost
color scheme of | the model to specific portion of | estimates for /%/
the model other software | the model construction

8 | What is the purpose of "Families" in Revit?

e

A) To represent
groups of
architects

B) To organize
project files

C) To manage
project schedules

D) To define reusable
building components

9 | Which feature in Revit helps ensure

that changes made in one view are

)

automatically reflected in all related views? 4
NI B) Styles C) Filters D) Renderings
Templates

10 | Which Revit tool allows you to create 3D models by extruding 2D shapes?

A A




A) Extrude tool

| B) Convert tool | C) Build tool

| D) Extend tool

11 | What is a "Sheet" in Revit used for?
i C) A printed or
Qlﬁ‘(:lr;lézl for S&Qgﬁﬁl far digital D) A tool for managing /[4
pace ing representation of | building components /]
collaborating rough ideas :
a drawing
12 | What is the primary purpose of using "Tags" in Revit?
A) To label C) To apply
: B) To create D) To generate [
elemgnts Ina 3D models fextiesita construction schedules ﬂ
drawing surfaces
13 | What is the purpose of the "Project Browser" in Revit?
| A) To browse the | B) To access
internet for project C) '_l'o Manage D) To connect to cloud | [ 4]

: project files and . -
design management ViEHS storage services /
inspiration software

14 | What does the "Render" tool in Revit allow you to do?
C) Create
A) Organize E) Bxport visualizations of D) Qenerate Cos [}
s models to e estimates for A
Blojoeties other formats | e building’s construction .
appearance
15 | In Revit, what is a "Curtain Wall"?
A) A wall with B) A type of C) A decorative D) An exterior wall /[/j
curtains for window architectural system with glass d
privacy treatment element panels
16 | How can you adjust the visibility of objects in different views using Revit's
"Visibility Graphics" tool?
B) By C) By controlling /{4
A) By resizing changing the the visibility of D) By creating new
objects materials of categories and objects
objects elements
17 | Which tool in Revit is used for creating a 3D view of the building's exterior? [
A) Elevation tool | B) Section tool | C) Floor Plan tool | D) Perspective tool AJ/
18.| What is the purpose of "Worksets" in a collaborative Revit environment?
D) To enable multiple
A).To cregte B) TO Mahoge C) To organize users to work on /[D/]
backups of project b :

- : project teams different parts of the

project files schedules : L
project simultaneously
19 | Which Reuvit feature allows you to adjust the materials and finishes of building
components? /[,B/]
A) Material B) Material | &) color Picker | D) Texture Tool
Library Painter
20 | How can you add dimensions and annotations to a drawing in Revit? ([4

A) Using the Text
tool

B) Using the
Line tool

C) Using the
Dimension tool

D) Using the Paint tool
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= In the “Open” dialog box, browse to the Chapter02 folder.
= Double-click Chapter02.rvt to open the project. You can also select it and then click the Open button.

The project will open in displaying a sheet with an overhead 3D view.
The dataset for this chapter provided courtesy of Mark Schmieding, FAIA.

GETTING ACQUAINTED WITH THE PROJECT

For this tutorial, we will explore a series of sheet views included in the project. A sheet view is a special kind of view
that emulates a sheet of paper from which drawing sets can be printed to output devices. Sheet views typically include
a title block which contains project and drawing information. Revit remembers the last view that was open when
the project was saved. In this case, it is a three-dimensional aerial view of this small one-floor project for a youth

center. It includes offices, exam and counseling rooms, a multipurpose room, and media rooms. Let’s take a closer

look (see Figure 2.10).

- Phlebatomy / ‘
Lsb Room |

= Toilet

—— Drop-in
Center

R W S RS - AT e AR R R b [ 005 | “Description | Date e e 5 s
PAUL F. AUBIN ||Social Services Board Function Diagram 2|
CONSULTING SERVICES 1 R a|
www.paulaubin.com || Youth Center e — g‘

3|
|

Revit Essentials for Architecture by Paul F. Aubin Copynght (C) 2020 Paul F. Aubin

FIGURE 2.10 T7he Youth Center dataset shown from the “Function Diagram” sheet

VIEW NAVIGATION

You can use the wheel on your mouse to zoom in and out in any view. You can hold the wheel in and drag to pan the
screen. If you are working on a laptop and don’t have a wheel mouse, you can use the commands on the Navigation
Bar (located by default in the upper right corner of the view window) to navigate in any view. Depending on the
kind of view active on screen, you will have access to differing tools on the Navigation Bar (see Figure 2.11). Among
these are the Steering Wheel, the Zoom pop-up, and the ViewCube. The ViewCube and 3D steering wheel appear

in 3D views.

e Revit Essentials for Architecture ©
Copyright (c) 2020 Paul F. Aubin, All rights reserved
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FIGURE2.11 Zoom the sheet to Sheet Size and pan around to see it as it will prins. Pan with the wheel mouse or the steering wheel

NOTE: Revit includes 3D connexion device support. If you have one of these devices connected to your
computer, you can use it to navigate in 2D and 3D views. Additional icons will appear on the Navigation
Bar indicating that the device is detected and available for use in Revit. Learn more at: 3dconnexion.com.

The zoom pop-up offers many ways to zoom the current window. Most of these commands will be available in all
kinds of views, like: Zoom To Fit (which fits the screen to the extent of the model) and: Zoom In Region (which
allows you to drag a rectangular region on screen to magnify that area). We also have the handy: Zoom Sheet Size
available. This command zooms a view to a size comparable on screen to the actual size it will appear when printed.
Since Revit displays line weights and other graphics accurately on screen, this can give you a good preview of how
the sheet will look when printed (with today’s high resolution monitors, this is a good approximation). Each of the
zoom commands has a command shortcut that you can execute via the keyboard. These shortcuts are two characters
and you simply type both characters in succession to execute the appropriate command. For example, to issue Zoom
to Fit, you can simply type: ZE. All of the zoom shortcuts are shown in Table 2.D.

TABLE2.D Keyboard shortcuss for Zoom commands

Zoom Command Keyboard Shortcut
Zoom in Region ZR

Zoom Qur (2x) Z&y

Zoom to Fit ZF

Zoom A]} to Fit : ZA '

Zoom Sheet Size ZS

Previous Pan/Zoom P

1. From the Zoom pop-up on the Navigation Bar, choose: Zoom in Region.

You can also type ZR to issue this command. if Zoom in Region is already selected {a checkmark
appears next to it) then simply click the zoom icon to execute the command.

= Drag a rectangular region around the upper left corner of the drawing.
2. Hold in the wheel on the mouse and drag around to pan the model.

If you prefer, you can use the scroll bars instead.

The image you see on screen is the view named: Large Overview. It is in the 3D Views branch of the Project Browser.

It has been added to the current sheet and displays in a “Viewport™.

< Zoom back out. The easiest way is to choose: Zoom to Fit from the Zoom pop-up menu (shortcut: ZF).

* The Aubin Academy *
Copyright (c) 2020 Paul F. Aubin, All rights reserved
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The Steering Wheel offers an alternative to wheel mouse navigation with such commands as dynamic zoom and
pan. Click the Steering Wheel icon to make it appear. In this case, since we have a sheet active, only the two-di-
mensional commands will appear. (This is true even though a 3D view is placed on the sheet; the sheet itself is still
two-dimensional).

4. Click on the Steering Wheel icon (the tool tip will read “2D Wheel”).

Each function works the same way. Place your mouse on the area of the wheel for the function you want. It will
highlight as your cursor passes over it. You are also simultaneously moving the wheel around the screen with the
movement of your mouse, so it takes some practice. Click and drag with the mouse to begin the function. For exam-
ple, if you wish to zoom, move the wheel to the area of the screen that you wish to center your zoom on, move the
pointer over the Zoom part of the wheel, click and hold down the mouse and begin to drag. Dragging up zooms in,
dragging down zooms out. Varying the speed of your dragging varies the speed of the zooming. Release the mouse
button to stop zooming and make the wheel reappear to change functions. Pan works the same way except that

panning occurs in the direction that you drag (see Figure 2.12).
T Drag vy
e 100m

nes

Drag doen
to zoom out

Clice ané drag on the rewind to meve backward
and forward tarough your 20cm and pan histary

FIGURE 2.12 Steering wheels offer many view navigation functions. Drag on the part of the wheel labeled for the function you want to use

As you perform several zooms and pans, they are stored in memory. You can use the Rewi nd function to back up
through previous zooms and pans in a visual way. Move your mouse pointer over the Rewind function, click and
hold down. A ribbon of thumbnail previews will appear, each representing a previous zoom or pan. Drag to the left
to highlight previous zooms and pans, drag back to the right to move forward. Release the mouse to stop rewinding
or forwarding. When you are done with the wheel, click the small dose box (“X”) in the upper right corner of the

wheel or press Esc.

5. When finished experimenting with Steering Wheel, close it to continue.

UNDERSTANDING SCREEN TOOL TIPS : '

You can get feedback on the elements onscreen as your mouse passes over them.

1. Zoom to Fit. (In addition to the methods already covered, you can right-
click to access common zoom commands like Zoom to Fit.

=2 Move your mouse pointer into the middle of the screen and pause
it there—pause over the drawing, (not a text note).

Do not click the mouse.

Notice how a rectangular border highlights around the 3D image. As you pause the mouse, an onscreen tool tip
should appear as well. In this case, this tip will read: Viewports : Viewport : No Title (see Figure 2.13).

NOTE: The same information appears in the status line at the bottom left corner of the Revit interface.
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The tool tip conveys three bits of information about the element highlighted—its Category : Family name: Type

name. So, in this case, the element category is “Viewports,” the family is “Viewport” and the type is “No Title.”

2. Now hover the pointer over a piece of text but do not click.
This is called “Pre-highlighting.” The tool tip for a piece of text will read—Text Notes : Text : 3D Notes. Here, Text
Notes is the category, Text is the family and 3D Notes is the type. Since the 3D view is a viewport containing one
of our project views, you do not see the elements within the model pre-highlighting. However, you can choose to
“Activate” the viewport and that will give you access to the building model elements shown within the view. Editing

them from a viewport is no different than opening the view from the Project Browser and editing them there; the

results are the same view either way. Let’s take a look. , s
3. Pre-highlight the viewport, and then click to select it this time. ‘
= On the Modify | Viewports ribbon, click the Activate View button (you can double-click inside the viewport as well).

Notice that the sheet title block and the text labels have grayed out. While they are still visible, this graying effect

indicates that they are currently inactive and that you are now working inside the viewport.

4, Move the mouse around the model.

Notice that the elements within the model now pre-highlight.
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FIGURE 2.14 Once the viewport is activated, you can pre-highlight the elements in the model

We will not actually edit any model objects in this view but do take notice of the tool tips. The interior partitions,
for example, display as: Walls : Basic Wall : Generic - 6". The category is: Walls, the family is: Basic Wall and the
type is: Generic - 6" (see Figure 2.14).

Feel free to select objects if you like, but don’t edit anything. If you accidentally move or change an element, click
the undo icon on the Quick Access Toolbar (QAT) at the top left corner of the Revit interface. Or press cTrL + z.

You may also notice that with the three-dimensional view now active, in addition to the Navigation Bar, the ViewCube
is also displayed. The ViewCube is a 3D navigational tool available in all Autodesk products. Clicking on any of the
labeled sides of the cube will orient the view to that direction such as top, front, or right. There are also several active
regions between faces that will orient the view at an angle between the two adjacent faces. For example, click the
edge between front and right to orient the view to the southeast. Click the corner berween three faces to orient the
view to an axonometric orientation. You can also click and drag any edge of the cube to orbit the model in real-time.

Feel free to experiment with the ViewCube to get the hang of it (see Figure 2.15).

FIGURE 2.15 T7hree-dimensional views show the ViewCube. Use it to quickly reorient the 3D view

In addition to the ViewCube, the Steering Wheel has more options in a three-dimensional view. You can orbit the
view, change the center of rotation, move the vantage point up and down, and walk and look around the model.
Consult the online help for more information on these options and the many ways you can customize the Steering

Wheels to suit your preferences.
5. Feel free to experiment with the ViewCube and the 3D Steering Wheel in this 3D view.

= Before continuing, reset the view back to its original state.
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To do this, click the Steering Wheel, and then use the Rewind tool or right-click on
the Steering Wheel and choose: Undo View Orientation Changes.

6. When you are done exploring in the model, right-click in the Viewport again and choose: Deactivate View.

This returns you to the sheet and the elements in the view are no longer selectable.
VIEWS AND DETAILING

Earlier we discussed how model and annotation elements were handled in distinct ways. Continuing in this file, let’s
explore the difference between model and view-specific/annotation elements a bit further.

13 On the Project Browser, beneath the Views (all) branch, double-click to open the: _Main Floor plan view.

This is the basic floor plan view for this project.

2. On the Project Browser, double-click to open the _Room Callouts plan view.

This plan is very similar to the _Main Floor view except that it also includes callouts around the General Purpose
Room on the left and some elevation and section markers. A sheet has been provided showing each of these views.

3. On the Project Browser, beneath the Sheets (all) branch, double-click to open the 05 — Room Callout sheet view.
Notice how the only visual difference here is that the plan appears on a title block sheet in this view.

4, On the Project Browser, double-click to open the 02 — Floor Plan sheet view.

This is the sheet presentation of the _Main Floor plan view. In other words, this sheet composes the _Main Floor plan
view on a title block for printing. You can easily see which views appear on a sheet in the Project Browser.

5. On the Project Browser, beneath the Sheets branch, expand the tree (click
the small plus (+) sign) beneath the 01 — Shaded Plan sheet.

= Double-click the sheet to open it (see Figure 2.16).
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FIGURE 2.16 Expand the sheet entries in the Project Browser to see the views they contain
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This provides an easy way to see which views are inserted on sheets. Another useful tool (noted above) gives us a way
to see which views have not yet been placed on sheets.

6. On the Project Browser, scroll to the top and select the Views (all) branch.

> On the Properties palette, from the Type Selector {(drop down list at the
top), choose: not on sheets (similar to Figure 2.9 above).

Notice that the list of views on the Project Browser now shows only those views that are not yet assigned to a sheet.

In this project, there are only a couple views not placed on sheets. Expand each sub-group o see.

7 Make sure that “Views (not on sheets)” is selected, and then on the Properties palette, change back to: all.

This sets the default browser organization back to showing all views regardless of their placement on sheets.

8. On the Project Browser, double-click to return to the _Main Floor plan view. Or just click its tab if itis still open.

Suppose that we needed to create another floor plan that was similar to this one, but that was to convey a different
type of information on the printed sheet or that we were planning to use simply as a convenient place in which to
edit the model with no intention of adding it to a sheet. To achieve either goal, we simply duplicate an existing view.

9. On the Project Browser, right-click the _Main Floor plan view and choose: Duplicate View > Duplicate.

A new floor plan view named: _Main Floor Copy 1 will appear and become active. Notice that none of the room
labels or dimensions were copied in this operation. This might be useful if you were creating a “working” view. A
“working” view is intended as a view in which you manipulate the model only and do not plan to add to a sheet for
printing. Bear in mind that nothing prevents the working view from being used on a sheet; rather it is simply not
intended for that purpose by our project team. If we want to duplicate the view, including the tags and dimensions,
we choose a different command.

10.  Onthe Project Browser, right-click the original _Main Floor plan view again
and choose: Duplicate View > Duplicate with Detalling.

NOTE: “Duplicate with Detajling”- is short for “Duplicate with view-specific detailing elements and
annotation elements.” Remember that the “detailing” is being copied, while the model elements are simply
being viewed. :

iy .

‘

A new floor plan view named: _Main Floor Copy 2 will appear and become active. Notice that this copy includes
copies of the room tags and dimensions.

=% Right-click _Main Floor Copy 2 and choose: Rename.
= Type: Area Diagram and then press enver.

11.  With the cre key held down, select each of the dimensions in the view (five total).

= Press the peceTe key.

We do not need dimensions for the new view we are creating. However, there is no way to duplicate only the room
tags and not the dimensions, so simply deleting them achieves the desired result. But the critical thing to remember

here is that the dimensions still exist in the original _Main Floor view. We only deleted the copied ones here.
12.  Onthe Annotate tab of the ribbon, on the Color Fill panel, click the Color Fill Legend tool.
A small square with a tag will appear attached to the cursor.

= Click a point above the plan to place the Color Scheme Legend.
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= In the dialog that appears, for Space Type, choose: Rooms and then click OK.

As you can see, the Scheme 1 color scheme color codes each room based on its name. The legend itself is currently

overlapping the plan. To make it fit better, we can resize and/or move it.

13.  Click on the Color Fill Legend and then drag the small round Control at the
bottom up to make the legend two columns (see Figure 2.17).
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FIGURE2.17 Create a Legend for the new shaded plan and then resize the legend

14.  Onthe Project Browser, double-click to open the 04 — Area Diagram sheet view.

A sheet appears on screen, which does not yet have a drawing on it. Let’s add our new shaded plan to this sheet.
> On the Project Browser, right-click the 04 — Area Diagram sheet and choose: Add View.
= From the “Views” dialog, choose: Floor Plan: Area Diagram view-and then click the Add View to Sheet button. g
= Click to place the view on the sheet. .
Notice that the view is a little too big for the sheet. We can adjust the scale of the view and it will update automat-
ically on the sheet.
15.  Onthe Project Browser, select the: Area Diagram view.

= On the Properties palette, from the View Scale list, choose: 1/8"=1'-0" (see Figure 2.18).

* The Aubin Academy <
Copyright (c) 2020 Paul F. Aubin, All rights reserved




Conceptual Underpinnings of Revit | 59

00 - Function Diagram {1} _ Main Floor 7 fcomCallouts | AreaDiagram B 04 - Area Diagram X [

Properties

W ) Floor Pian v

iFoor Plan: Ared Diagre
Graphics
View Scale

Areas

[enesctom (ot foom

[ shomer R

B oreer

Srgperties halp

Prpject Browser - Chapter02.nit
4 0. views (alp ~
= Floor Plans
_ Main Floor
_ Main Floor Copy 1
_Furniture Plan
_Room Callou
= Area Diagram
General Purpose Room

FIGURE 2.18 Change the scale of the view

| Social Services Board | = = = | Area Diagram |
| T L
}Youth Center | ;"::___:;"’ e \Bi i

You should see the change on the sheet immediately. If necessary, you can move
the viewport around to make a nicer composition on the sheet.

You should also look at the _Furniture Plan floor plan view and the 03— Layout Plan sheet next. In this view and
sheet, you will notice that the plan is displayed with furniture. Therefore, creating plans with and without detailing
(text and other annotartion) is not the only way to vary the specifics of what we see. We can also control the visibility
of each type of element in any Revit view. The visibility settings are a parameter of the view itself. This is how we
can choose to display the furniture in the _Furniture Plan view and not display it in the _Main Floor view. On the
View tab of the ribbon, on the Graphics panel, you can choose the Visibility/ Graphics tool (VG). This will display
a dialog listing all element categories and enables you to turn on and off these categories within the current view.
While we will discuss the specifics of this process in later chapters, the important point for this exercise is that this
sort of control is possible and extremely useful. If you wish to explore the “Visibility/Graphics Overrides” dialog,

please feel free to do so. Simply undo your changes before continuing with the lesson.

EDIT IN ANY VIEW

7 «

Perhaps the most powerful feature of Revit is the ability to edit in any view and see the results instantly in all views.

1. On the Project Browser, double-click to open the 06 — General Purpose Room sheet
view. Then on the View tab, on the Windows panel, click the Close Inactive button.

This closes all the other tabs. As you can see from this simple exercise, it is easy to end up with many open view tabs.
Using this tool every so often helps keep a tidy workspace and preserves computer resources. The 06 sheet we have

open shows a plan and four interior elevations. All these views show the General Purpose Room.
2. Select the plan view on the left, right-click and choose: Activate View (or double-click on the viewport).
3. On the Architecture tab of the ribbon click the Window tool.

= Click a point on the exterior wall on the left to add a new window (see Figure 2.19).
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FIGURE 2.19 Add a window and it appears in all appropriate views automatically

Notice that the window appears immediately in the north elevation (detail 5 on the sheet).

4, Right-click in the plan view again and choose: Deactivate View.

EXPLORE A DETAIL VIEW

As we have noted above, a detail view is a litte different than the other views. Typically it will include a live view of
the model—usually a callout of some part of a section or plan—and various types of annotation and other graphical

embellishments drawn on top. One such detail view has been included in this sample dataset.
1. On the Project Browser, expand (click the plus [+] sign) the 07 — Building Details sheet view.
Beneath this sheet is a listing of three views that are already placed on the sheet.
= Beneath the 07 — Building Details sheet view entry, double-click to open the: Section : Section Detail view.

2. Pre-highlight some of the elements in this view (see Figure 2.20).
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FIGURE 2.20 Explore a detail view—Note the combination of detail and model elements

Notice that the detail view contains both model elements (which would appear in all views) and detail elements
(which appear only in this view). Even though the detail elements represent items like concrete blocks, brick, flashing,
and bond beams, the level of detail required in a construction detail is much higher than that required in nearly any
other view. Therefore, these types of items are typically drawn as detail elements on top of the model view geometry
to keep overhead low and reduce the amount of time and effort required to build your overall model. An even easier

way to see this is to change the way the model displays on the Properties palette.
3. Make sure that nothing is selected (press esc). On the Properties palette, next to Display Model, choose: Halftone.
Notice how the elements that are parts of the 3D model now display grayed out.
= Set it to: Do not display next.
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This time the model disappears and only the detailing remains.
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Complete coverage of the detailing procedure can be found in Chapter 12. Continue to explore in this dataset as

much as you wish to get a better feel of how the various elements and views in a Revit project interact. Close Revit

when you are finished exploring. You do not need to save the file.
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CREATE A UNIQUE ELEMENT

The first floor existing conditions plan is nearly finished. We still need to add the fireplace in the living room and
stairs in the middle of the plan. While it would be possible (and maybe preferable) to create a fireplace family in
the Family Editor and save it in our library for use in any project, this would only make sense if we used the same-
fireplace design often. If you design a lot of homes that use the same fireplace, this is exactly whar you should do.
Refer to techniques in Chapter 11 to learn how to create a loadable component family. In this case, we will create

the precise fireplace we need for this project directly in-place. This is called an “In-Place Family.”

IMPORTANT: In-place families are not designed to be moved, copied, rotated, etc. They are meant to be used only
once. Ifyou need to use it more than once within this project or in a different project, a regular loadable component family
should be created in the Family Editor, saved to a library and then loaded into your project as needed. The Family Editor
will be explored in detail in Chapter 11.

CREATE AN IN-PLACE FAMILY

To get started, we will creare a new in-place family and assign it ro a predefined category. Revit has a long list of
predefined categories. Categories are at the top of the hierarchy discussed in the “Families & Types” topic on page
47 in Chapter 2.
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1. Zoom in on the middle of the right vertical exterior wall. This is where our fireplace will go.

2. On the Architecture tab, click the drop down button on the Component tool and choose: Model In-Place.

= In the “Family Category and Parameters” dialog, choose: Generic Models, and then click OK (see Figure 4.59).
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FIGURE4.59 Create an in-place fumily and choose its category

NOTE: Modeling in-place is not available in Revit LT. If you are using LT, you can create an actual component
family and load it instead. From the File menu, choose: New > Family. Then choose the Generic Model.rfi
[Metric Generic Model.rfi] template from the listand then dick Open. Add the reference planes as noted below,
but instead of measuring them from the existing walls, place them so that the rectangular space they describe
is centered on the two reference planes already in the template. Build the rest of the family following the same
steps indicated. Save the file when finished as: Fireplace and then load it into the project and place it where
indicated in the figures below. A version of this family is provided in the ChaprerO\Complete folder called:
Fireplace for LT vfa.

The family category list is a fixed list built into the software. When you create a family, you must assign it one of these
categories. The family you create will inherit the characteristics of the category to which it is assigned. In general,
when choosing a category, try to select the one that most closely matches the actual object that you are creating. The
Construction Specifications Institute (CSI) spec section for fireplaces is Division 10—Specialties (10300 Fireplaces
and Stoves), which would tempt us to choose “Specialty Equipment.” However, your choice of category does impart
certain behaviors to your family. Specialty Equipment is intended more for free-standing equipment items and does
not have a “cut” representation. Items like 10340 Manufactured Exterior Specialties, 10500 Lockers or 10670 Storage
Shelving are all examples of things that would work well in the Specialty Equipment category. Items in Revit that
are “cuttable” interact with the cut plane of floor plan and section views and show bold when cut and lighter when
viewed in projection. Since we will want our fireplace to interact with the wall and appear bolder when cut in plan,

we need a caregory that SUPPOI‘I,S cutting.

We get this cutting behavior because we chose the “Generic Models” category above. This is sort of a “catch all”

category. You typically choose Generic Models when the item you are modeling does nor fit neatly into any of the
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other categories. Generic Models does not impart any specialized parameters that might be available from other more
descriptive categories, but aside from the need for interaction with the cut plane, our existing fireplace has no other

specialized needs. So Generic Model will work OK here.
= In the “Name” dialog, type: Existing Fireplace and then click OK.

You are now in “In-Place family editing” mode. The model will gray out but remain visible for reference. The ribbon
tabs will change showing a collection of In-Place family editing tools instead of the usual tools. Take a look at the
Create tab for example(see Figure 4.60).
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FIGURE4.60 7he Family Editor mode is enabled when you creare a new in-place family

The Create tab includes many family editing tools. You can create solid and void forms, insert Components, or add
connectors. Simply click on the other tabs to access these tools as normal. Note that several tools like walls, doors,
and floors are not available in family editing mode. You cannot place (nest) a system family within another family.
Also notice that the “In-Place Editor” panel with its Finish and Cancel buttons appears on the right side of the

ribbon in all tabs.

ADDING REFERENCE PLANES

When you construct complex geometry, it is often useful to have guidelines to assist in locating elements. Reference
planes are used for this purpose in families. You sketch a reference plane like the way you sketch walls or lines. You
can snap and constrain other elements to reference planes, making them useful tools for design layout. You can add
reference planes in any orthographic view of the model. (Reference planes do not show in 3D.) In this example, we
will add them within our In-Place family. When you add them in this way, the reference planes will become part of

the In-Place family and will be visible only when editing the In-Place family.

1. On the Create tab, on the Datum panel, click the Reference Plane tool. (Do
not click Reference Line; make sure you click Reference Plane).

Click a pointinside the large room on the right near the exterior wal'l, just above the lower window.
= Move the pointer horizontally to the right past the exterior wall and then click outside.

The exact locations of either click are not critical so long as you draw horizontally and above the window.
A small reference plane (green dashed line with round blue handles at the ends) will appear.

= Edit the Temporary Dimension from the bottom horizontal wall to: 7'-11" [2400] (see the left side of Figure 4.61).

* The Aubin Academy *
Copyright (c) 2020 Paul F. Aubin, All rights reserved



Creating a Building Layout | 139

e H
then
nes Offset
= 7 % % = hers =7 N
4 3
B
=1 Oftset @ =
e ik copy bere [ Dow NT
Qh .l g ¥
%, RS {
!
€ =  wmeew B et T ST & D §
; 7 <
<Click 1o narg>’ = ieat 1
Draw & Lie First !
horizontat srap

referesce plane here

= A » } '/u
=9
1 L0
o a P e
34 { Lt WA
Ofiset: | 1900
| S PO SO |
f S b o
L] = =] S .05 55

FIGURE4.61 Create rwo horizonsal and two vertical reference planes 1o frame ous the fireplace footpring (dimensions for reference only)
3. On the Modify | Place Reference Plane tab, on the Draw panel click the Pick Lines icon.
= On the Options Bar, in the Offset field, type: 6'-2% [19001. ‘
<> Pre-highlight the first reference plane and move the mouse so that the offset line appears above.

Click to create the new reference plane (second panel from the left in Figure 4.61).

Now we'll repear the process to create two more vertical reference planes. These will frame out the rectangular foot-

print of the fireplace.
5 On the Draw panel, switch back to the Line icon, and then type: 4" [100] in the Offset field.
= Snap to the endpoint of the lower window on the inside edge of the wall.

= Snap to the endpoint of the upper window on the inside edge of the wall (third from the left in Figure 4.61).

TIP: Thestart and end points suggested will make the first reference plane fall to the inside of the house and

the second to the outside. If you click the points in the wrong order, do not cancel, simply tap the spacesar to
flip the line.

6. Switch back to the Pick Lines tool and then change the Offset to: 2'-7" [7801.

= Offset the reference plane you just drew to the outside of the house (see the right side of Figure 4.61).

We now have four reference planes that we can use to guide the creation of our fire-place’s form. This is common best

practice. Complete details on the use of reference planes in families will be discussed in Chaprer 11.

CREATE A SOLID FORM

Using our reference planes as a guide, let’s create the overall mass of the fireplace.
1. On the Create tab, on the Forms panel, click the Extrusion tool {see the top of Figure 4.62).

= On the Options Bar, in the “Depth” field, type: 8'-0" [2750]. (Be sure to
set the Depth and not the Offset—Item 1 in Figure 4.62.)

2. On the Draw panel, for the sketch shape, click the Rectangle icon (see item 2 in Figure 4.62).

= Snap to the intersection of two of the reference planes and then snap to an opposite
intersection to define the rectangular shape (see items 3 and 4 in Figure 4.62).

=2 Close all four padlocks {see item 5 in Figure 4.62).
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On the Modify | Create Extrusion tab, on the Mode panel, click the Finish
button (large green checkmark) (see item 6 in Figure 4.62).

This gives us our basic fireplace mass. We now need to carve out the firebox.

CREATE A VOID FORM

Using the same basic process, we can create a Void form that will carve away from the solid form in our family giving

us the firebox opening.

L

On the Create tab, click the Void Forms drop down button and then choose: Void Extrusion.
The Modify | Create Void Extrusion tab will appear with the same Sketch tools as before.
Onthe Options Bar, in the “Depth” field type: 4'-0" [1200].

On the Draw panel, click the Pick Lines icon.

Click the left vertical edge of the solid extrusion (see panel 1 in Figure 4.63).

A magenta sketch line will appear directly on top of this edge.

On the Options Bar, change the Offset value to: 1'-0" [300].

Highlight the right edge of the solid extrusion and move the mouse slightly until the dashed line is within
the fireplace structure. When it is, click to create a magenta sketch line (see panel 2 in Figure 4.63).

Change the Offset value to: 0 (zero).
On the Draw panel, click the Line icon.

Using the temporary dimensions as a guide, click the first point on the left edge a bit down from
the top corner and draw it down and to the right at a 20° angle (see panel 3 in Figure 4.63).

Click the Modify tool or press the esc key twice.
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FIGURE4.63 Sketch lines to form the firebox shape
6. Select the 20° line and then on the Modify | Create Void Extrusion tab, click the Mirror Draw Axis tool (or press DM).
> Click the midpoint of the vertical sketch line already drawn {see panel 4 in Figure 4.63).
= Move the mouse horizontally and click the finish the mirror line (see panel 5 in Figure 4.63).
The result is shown in panel 6. Now we will use the Trim/Extend to Corner tool (the same one we used for walls at
the start of the chapter) to clean up the sketch.
7. On the Modify tab, click the Trim/Extend to Corner tool {or Type TR).

= Trim all four corners to make an enclosed shape (see Figure 4.64).

REMEMBER: Select the portion of the sketch line that you wish to keep.

8. Click the Modify tool or press the esc key to finish trimming.
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FIGURE4.64 Edit the skexch lines to finalize the shape

9. On the Mode panel, click the Finish Edit Mode button.
While the void is still selected, it will appear solid. However, when you deselect, it will cut away from the previously
drawn solid to form the fireplace shape.

10. Clickin empty space to deselect the element.

11.  Onthe In-Place Editor panel, click the Finish Model button (big green checkmark).
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This completes the editing of our family and returns us to the project editor mode.

JOIN THE FIREPLACE WITH THE WALL

The Fireplace family is finished but it overlaps the wall. Lets fix this.
1. On the Modify tab, click the Split tool (or type SL).
= On the Options Bar, place a checkmark in the “Delete Inner Segment” check box.
2. Split the exterior vertical wall on both sides of the fireplace (see Figure 4.65).
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{ §

» B [ XKeeG8 B AfREeE s 2 {0 ;
Modify | B aste T G- & 8- + On R r = ;
Bl v em-ga PBOHaaxw I GF
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FIGURE 4.65 Split the exterior wall

3. Click the Modify tool or press the esc key twice.

This is close to what we want but let’s make one more edit.
4. On the Modify tab, on the Geometry panel, click the Join tool (see the top of Figure 4.65).

= Click one of the exterior walls (the ones we just split).

= Then click the Fireplace to join them (see Figure 4:66).

Remember to watch the Status Bar for detailed prompts.

5. Repeat for the other wall. Pick the wall then the fireplace.

Second pick | Result l Repeat

=

V First pick

Kowe: 55 @ |
S =8 |
[Eoni] 2 & |

FIGURE 4.66 Use Join Geometry to join the walls to the Fireplace
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6. Click the Modify tool or press the esc key twice to cancel the Join command.
7. On the QAT, click the Default 3D view icon.

= Use the techniques covered above and orbit the model around so that you can see the Fireplace.

We modeled the fireplace a bit too short. However, for now we will leave this alone. In later chapters we will address
the height of the fireplace as well as how it changes width on the second floor. The fireplace could also use a mantel
and a hearth. However, because there will be no new work done in the living room of this project and therefore no
sections or elevations are needed of the fireplace, that extra level of detail is unnecessary for this tutorial. What we
have created works well for the floor plan. If you wish to try it anyway for the practice, feel free. Select the fireplace,
and then on the Modify | Generic Models tab, click the Edit In-Place button. This will return you to the in-place

family editor where you can add these accoutrements using additional solids.

RESET THE CURRENT PHASE

Congratulations! Our work on residential project first floor existing conditions layout is complete for now (see Figure .
4.67). We still need to add the Stairs to this model. However, Stairs will be covered in a dedicated chapter. Therefore,

we will save our layout without the Stairs for now.

—

FIGURE 4.67 The final first floor existing conditions layout
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CREATE A SHEET LIST

Revit makes it easy to create a list of all the drawing sheets in our project. A sheet list will resemble the other schedules
that we already have, and it can even be placed on a sheet as a sheet index. Furthermore, it can be used to help us

create and edit the sheets in our project. Let’s create a sheet list and then use it to add more sheets.
1. On the Project Browser, right-click on the Schedules/Quantities branch and choose: New Sheet List.
= In the “Sheet List Properties” dialog, select Sheet Number and then click the Add parameter icon in the middle.

= Add additional fields like Sheet Name, Drawn by, Checked by, Sheet Issue Date and Guide Grid.

TIP: As an alternative to clicking the Add icon, simply double-click the field you want to add.

2. Click the Sorting/Grouping tab.

= For Sort by, choose: Sheet Number and then click OK.

Fields like drawn by, checked by, and other similar text fields must be edited individually on each sheet. However,
one of the benefits of the Sheet List schedule is that you can edit those values directly in the table, which is usually
more efficient than doing them individually. Another key advantage to the Sheet List Schedule is that we can use it
to create Sheets. Think of it as queuing up list of available sheets, complete with pertinent information filled in and

ready to add to the project.

3. On the Modify Schedule/Quantities tab, on the Rows panel, click the Insert Data Row button.

A new row will appear in the Schedule. It will automarically number as sheet A102. Using this method, you can

create several “placeholder” sheets and fill in their values in the other columns of the Schedule.

= For the name of A102, begin typing: Floor Plans. After the first letter or two, Revit will guess the name from
your previously input values. You can keep typing, or just choose from the mini pop-up (see Figure 5.46).
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FIGURE 5.46 Create a drawing list and use Insert Data Row to add a placeholder sheer

= You can input your own initials in the “Drawn By” and “Checked
By” fields and input a date for sheet issuance if you like.

Using Table 5.A, we'll set up the rest of the floor and ceiling plan sheets.
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CREATE THE REMAINING FLOOR PLAN SHEETS

Let’s create the remaining floor plan sheets.
1. On the Project Browser, select the Level 2 floor plan.
= On the Properties palette, change the “Title on Sheet” parameter to: Second Floor Plan.

= Repeat this process for each view listed in Table 5.A.

TIP: if you prefer to input the Title on Sheet parameter in a schedule, try making a View List. The process is
the same as adding a Sheet List and you can you add the Title on Sheet parameter field to the View List. This

will enable you to quickly edit it from the Schedule.

2. Repeating the process outlined above, in the Sheet List Schedule, click the Insert Data Row
button for each of the sheets listed in the “Drag to Sheet” column of Table 5.A below.

a

Each time you click, check the number in the Sheet Number column and edit as necessary. They will
number in sequence, so with a little strategy, you can reduce the amount of renumbering you have to do.

3. Using the values in the table, fill in the sheet names (and other fieids if desired).

TIP: To reuse existing values in the Schedule, click the drop down arrow in the text field.

TABLESA Titles on Sheets for Plan Views

View Name Title on Sheet Drag to Sheet

Floor Plan Views

Level 2 Second Floor Plan A102 - Floor Plans

Level 3 Third Floor Plan A103 - Floor Plans

Level 4 Fourth Floor Plan A104 - Floor Plans

Roof : Roof Plan : Al105 - R(;of Plan

Site Plan Architectural Site Plan A100 — Architectural Site Plan

Ceiling Plan Views

Level 1 First Floor Reflected Ceiling Plan Al11 - Reflected Ceiling Plans
Level 2 Second Floor Reflected Ceiling Plan A112 — Reflected Ceiling Plans
Level 3 Third Floor Reflected Ceiling Plan A113 — Reflected Ceiling Plans
Level 4 Fourth Floor Reflected Ceiling Plan A114 — Reflected Ceiling Plans
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NOTE: The sheer numbers suggested here are based on the US National CAD Standard recommendations.
If you prefer a different sheet numbering scheme, feel free to use it instead.

TIP: If you want to quickly input the Drawn By and Checked By fields, you can make the Sheet List schedule
the active tab, then on the Properties palette, click the Edit button next to Sorting/Grouping. In the “Schedule
Properties” dialog that appears, set the Sort by to (none) and uncheck “itemize every instance.” When you

click OK, you will have a single line item in the schedule. Edit the values for Drawn by and Checked by. Do not
edit any other fields as when the schedule is configured this way, you are editing ALL sheets at once. When you
are finished, retum to Sorting/Grouping and reset to Sort by Number and turn itemize every instance back on.

CREATING SHEET VIEWS FROM PLACEHOLDER SHEETS

We now have nine new placeholder sheets in our sheet list, but if you look at the Project Browser, we still have just
the one sheet. The purpose of adding placeholder sheets is that it allows you to configurea list of standard sheets and
to input all the fields before you need the sheet in the set. Another useful purpose of placeholder sheets is to allow
the addition of consultant sheets to the sheet list without having those sheet views listed in your Project Browser.
When you are ready, you simply add a new sheet as we did before, bur this time we will be able to choose from the

list of available placeholder sheets.

If it is not already, open the Sheet List schedule.

NOTE: On the Modify Schedules/Quantities tab, on the Filter Placeholder Sheets tab, there are three
buttons. The default one is: Show. This shows both placeholder and actual sheets in the list. ‘The Hide butron
hides the placeholders showing only the actual sheets in the list and the Isolate button does the opposite. Try

these out before continuing if you wish.

1. On the Modify Schedules/Quantities tab, click the New Sheet button.
This is the same as right-clicking the Sheets (all) branch on the Project Browser as we did above.
Notice the list of placeholder sheets at the-bottom.

2. Select A100 in the list. Hold down the sHiFT key and then select A114 and then click OK (see Figure 5.47).
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Nine new sheets will appear on the Project Browser ready for you to drag and drop views. Zooming in on the title
blocks will reveal that all the data input in the Schedule is already filled into the appropriate fields. Now that we have

all our plan sheets created, let’s add the views to them.

Right now, we will simply drag the views onto the appropriate sheets and place them in approximately the same
location. Once we have the Structural Grids in Chapter 6, we can adjust the position of the manually placed views
to make sure that they all align with one another using the Guide Grid feature. With the Guide Grid feature you
can overlay a grid on top of a tidle block sheet and use it to keep similar views lined up across multiple sheets. But
since it requires the column grids, we will wait till Chapter 6 to explore that feature.

3. Using Table 5.A above as a guide, drag each of the floor and ceiling plan views onto their respective sheets.

= Place each one in the same general area on the sheet.

e s —

NOTE: : :'orkmg in the Metric files, the scale of the Site plan should be changed before adding
to the sheet. To do this, open the Site plan view, scroll down anid dlick the button next to View Template and
then in the dlalog that appears, change the scale to: 1:200.

If you \ar'

4, Save the project.
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EDIT VIEW RANGE

Before we complete the stair tower roof, let’s adjust the roof plan a little. The primary view range only
displays elements at the Roof level to the cut plane. This is the default behavior. And as we noted previously, the
new roof does not display in the Roof plan currently because it is above the cut plane.

1. On the Project Browser, double-click to open the Roof plan view (or just click its tab if you left it open).
Make sure that you have no objects selected, then on the Properties palette, edit the View Range (or press VR).

Change offsets of both the Primary Range Bottom and the View Depth to: -1'-0" [-3001.

8 » 3

Change the Offset of the Cut Plane and the Top to: 20°-0" [6000] and then click OK.

These adjustments give a generous range for the geometry on the roof and allow some flexibility in future edits. Notice
that the core roof now displays in the plan view.

NOTE: With the settings this way, we do not have a'vpl'an that shows the upper level of the stair tower. If
you wish to create such a plan, make a duplicate of your Roof plan before making the previous edit.

USING SHAPE EDITING TOOLS

The final exercise in this chapter will be to add drainage sloping to the commercial project flat roof. To accomplish
this, we will look at the third and final way that you can apply slope to a Roof: Shape Editing tools. When you have
a flat roof or floor element in your model (no edges sloped and no slope arrows), you will see the Shape Editing panel
on the Modify | Roofs tab of the ribbon when the roof or floor is selected. If even one edge of the roof or floor is set
to slope defining, the tools will not appear (see Figure 9.52).

Please note that if you are using Revit LT, you will not have access to the shape editing tools. Please skip this topic.
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FIGURE 8.52 Roofs or floors with no sloping edges in their sketch have access to the shape editing rools
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Continue in the Roof plan view.
1. Select the flat roof element. (Use the 1aB key as necessary.)

Notice the collection of Shape Editing tools appears on the ribbon as shown on the left side of Figure 9.52.
Moving left to right, the tools are as follows:

Modify Sub-Elements—This tool can be used to adjust the height of any points or edges of the shape edited element.

Add Point—Use this tool to add points to the surface of the roof or floor. Each point has a height that you can adjust
to either a negative or positive offset from the roof or floor level. The roof form will conform to the shape of the edited

points.

Add Split Line—This tool adds elevation changes using lines instead of points. Like the Draw Point tool, each line
has a height that you can adjust to cither a negative or positive offset from the roof or floor level. You can also edit the

height of the line’s endpoints independently.

Pick Supports—If you have structural supports set at accurate levels, you can use them to indicate the level changes

of the roof or floor.

Reset Shape—The button (grayed out in Figure 9.52) is used to remove all edits and return the shape of the roof or

floor to flat with no slopes.

We'll perform a simple edit to our roof’s surface using a few split lines and points.

2. On the Shape Editing panel, click the Add Split Line tool.

This enables a special shape editing mode which is like other sketch modes but has some unique features as well. The
main difference is that there is no finish edit mode and cancel buttons. To exit this mode, simply click the Modify
tool as you would any other command. The existing edge of the roof outlines in a dashed green line. New points or
lines you add will be blue. Gray lines appear when required. They are auto-calculated from the other lines and points.
These turn out to be trickiest part of using these tools. If you want to avoid many unnecessary gray lines that make

the shape of the roof overly complex, you need to be strategic with your use of split lines and points.

3. Click a point at the intersection of Grid 2 and the vertical green line on the left.

’

= Draw straight across along Grid 2 and snap to the opposite green line on the right (see the left side of Figure 9.53).

— . 1
Addins | Modify|Roofs | (= i : i 174
: e ; Vi ;%__ o

3
4N

5

Modify s

Sub Elemnents 6 Pitk Supports | gjana i _"2 i ‘ il )
Shape Editing § —L——// -+
i Snap from point
i ; to intersection

: '\_,— Snap from here to Bz
here along Grid 2

FIGURE 9.53 Add split lines to divide the roof into three zones
4, Remaining in the Split Line tool, click the green corner point at the lower left side of the stair tower area.
= Draw horizontally to the left and snap at the intersection of the vertical green line.

= Repeat on the other side (see the right side of Figure 9.53).
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This divides the roof into three horizontal bands, with the top band being separated into
two sections by the stair core in the middle. Let's slope each of these areas.

On the Shape Editing panel, click the Modify Sub Elements tool.

= Select the horizontal dashed green line at the bottom of the plan (along Grid 1).
A temporary dimension will appear at the midpoint.
= Click in this temporary dimension and input: 6" [150] and the press enTer (see the left side of Figure 9.54).
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FIGURE 9.58 Edit the height of the split lines
6.

Remaining in the Modify Sub Elements tool, drag a selection window
around all three lines near Grid 3 (two blue and one green).

On the Options bar, change the Elevation to: 6" [150] and then press enter.

Alternatively you can do the two blues lines one at a time. The green will
end up in the same spot once you change both biue ones.

If you want to see the results of this change, you can create a section running vertically cutting through all three

zones. When you do, you will see the roof has a slight zig-zag shape to it now (see Figure 9.55).
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FIGURE 9.55 View the results of the Modify Sub Elements edits in a new section

To Ensure we have proper drainage, let’s add some crickets to the roof. This can be done by adding and editing

additional points and split lines.

Continue in the Roof plan view.
On the Architecture tab, on the Work Plane panel, click the Reference Plane button (or press RP).
On the Draw panel, click the Pick Lines tool. On the Options Bar, set the Offset to: 7'-0" [2100].

Offset two reference planes from Grid 2, one above it and one below and
then click the Modify tool or press esc twice to finish.

Select the roof again. (Clicking on the spiit line is the easiest way to select it).

On the Shape Editing panel, click the Add Split Line button.
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> Snap to the intersection of Grid C and the reference plane and draw to the intersection of the other reference plane.

= Repeat at Grid E (see Figure 9.56).
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9. On the Shape Editing panel, click the Add Point button.

= Snap to the midpoints of each of the three blue segments along Grid 2.

= Repeat at each location shown on the left side of Figure 9.57. Snap to midpoints at all locations.
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FIGURE 8.57 Add points at several midpoints
10. Onthe Shape Editing panel, click the Modify Sub-Elements button.
= Select each point circled on the right side of Figure .57 and edit the Elevation to: 6" [150].
As you make these edits, you will see gray lines appearing automatically as the shape of the roof adjusts.

Changing views will terminate the sub-element editing mode. You can also click the Modify tool first if you prefer.
Notice that the roof now displays the edges of the ridges and valleys for the sloping planes (see Figure 9.58).
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FIGURE 9.58 Study the results in 3D

ADJUSTING SLOPE

When designing a flat roof, there is often a minimum slope required by code for drainage. While we cannot input
this directly in the shape editing tools, we can use a simple technique to measure the slope that results from our edits

and then make appropriate adjustments.
1. Return to the Roof plan.
2. On the Annotate tab, on the Dimension panel, click the Spot Slope tool.
= Move your mouse around the various surfaces of the roof.
The spot slope annotation symbol will appear on your cursor and will read the slope of each surface as you mouse over
them. Use this moussing technique for quick measurements or click to place the permanent annotations in the view.
3. Click to place one or more spot slope symbols.
= On the ribbon, click the Modify tool or press the esc key twice.
If you discover a slope that is too shallow, simply select the roof, click the Modify Sub Elements button and then
adjust the height of some of the points or lines to adjust the slope. You will get immediate feedback from the anno-

tation as you make changes to the heights of the lines or points. In some cases, you may need to add new points or

lines to achieve positive drainage at all points on the roof.

USING VARIABLE THICKNESS LAYERS

The default behavior in the sub-element editing mode is for the entire roof slab to be affected by the slope. If you prefer,
you can edit the structure of the roof type applied to the roof element and make one of its material layer thicknesses
variable. When doing so, the bottom surface of the roof will remain flat, while the top surface slopes according to
the split lines and elevation points added above. This is an effective way to represent tapered rigid insulation in the
construction (see the next few steps). The best way to see these sometimes subtle variations is in a section view. Lets

use theéone we created earlier.
1. On the Project Browser, locate Section 1.

= Right-click it and choose: Rename. Call it: Section at Roof. Stretch the bottom of the
crop region up so that it only shows us the roof, cropping out the levels below.

Take a close look at the roof element. Notice that both the top and bottom surfaces are sloped (maintaining a uniform

thickness). We can designate one of the layers in the roof type structure as a variable thickness. When doing so, the
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bottom layers will remain flat, the variable layer will have a flat bottom and sloping top surface, and any layers on
top of the variable one will follow the slope (with uniform thickness).

2. Select the roof.

<> On the Properties palette, click the Edit Type button.
3. Click the Edit button next to Structure.
=

Place a checkmark in the “Variable” column next to layer 2 and then click OK two times (see Figure 9.59).

Lavers

_ Function | Malerid | Thickness ‘Wraps.

r—' Not var‘wlble
f
2 Strctere(t] <8y Categar T O°

I I f I 3 Core Boundar Layers Below 0 0"

Lavers

Variapie
{ . Function I Material . Thickness Wraps  Veriable
! i Core Boundar Layers Above 0 0° . -

i

i

¥ ¥

FIGURE8.58 Comparing the roof with and without a variable thickness layer

Currently we are using a Generic type with only a single layer. To appreciate fully the effect of a variable component,
we should assign a complex roof type.

4, With the roof still selected, from the Type Selector, choose: Steel Truss - insulation
on Metal Deck - EPDM [Steel Bar Joist -Steel Deck -EPDM Membranel.

5. Edit the “Type Properties” again and then click the Edit button next to Structure.

= Place a checkmark in the “Variable” column next to layer 2 (the insulation this time) and then click OK two times.

Now that we have a more detailed structure in place you can see that we have effectively represented tapered insula-
tion and the support structure beneath it remains level. However, this roof type’s lowest layer is meant to represent
the steel bar joists. This means that the entire roof structure sits too high in the model.

6. Select the roof, and on the Properties palette, in the “Base Offset From
Level” field, type: -1'-4" [-400] (see Figure 9.60).

I ' I

FIGURE 8.60 Adove the roof element down with a negative offser from the level

Feel free to study the model in other views and experiment further with the roofs and floor slabs.

7 Save and Close the commercial project file.
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FIGURE 12.22 View break controls allow you to crop out the middle portion of the section

2. Click one of the view break controls on a vertical edge (there are four
total; you can pick any one) of the crop boundary.

The view splits into two separate crop regions with a large gap in the middle. A blue arrow control handle appears
in the middle of each view break region. We can use these to move the two portions closer together. Notice that
along the vertical edges of each of the two new crop boundaries the same types of control handles appear. You can
continue to break them into additional sub-views as necessary. But all breaks must be along the same direction as
the first one—vertical in this case. In this example two is enough so we will not break it any further. However, we
need to adjust the top view break so we can see the entire anchor bolt.

3. Using the blue dot control handle at the bottom of the upper view
break, drag the edge down a bit to show all the anchor bolt.

> Click on the view break control (in the middle) of the bottom view break and drag it up so the
crop region is a little below the upper crop boundary (see the right side of Figure 12.22).

If you continue to drag so that you overlap the two view breaks, they will join back into one. This is how you “remove”

the break.

CAUTION: Besure to4move the portions of the vieW breaks with the control arréw in the middle.
Do not drag the edge of the crop region. Doing so will move the area of the callout in both this view
and the referring Longitudinal section view.

Although the sub-views are truncated and closer together, distances are dimensionally correct. Look at the level lines
to the right of the views and note that the heights are unchanged. If we were to add a dimension from the First Floor

to the Basement, it should read a distance of: 8'-9" [3540]. Lets try it out to see.
4. On the Annotate tab, on the Dimension panel, click the Aligned tool.
= Add a dimension between the First Floor level and the Basement level.

= Move to the left crop region boundary and click next to it (in the white
space) to place the dimension string (see Figure 12.23).
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As you can see, applying a view break is a graphical convention only and has no impact on the dimensional accuracy
of the model being displayed in each portion of the crop boundary.

5. On the ribbon, click the Modify tool or press the esc key twice.

6.

7 Save the project.
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Add Break Line detail components on the foundation wall at the break between the two halves of the detail.
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